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Agenda
® 3:00 Welcome & Introductions

® 3:05 - 3:25 Systematic
Observation (Thom McKenzie)

® 3:30-4:30 Using iISOPARC App
Step-by-Step Interactive
Tutorial
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® 4:30 - 4:45 Mid-Session BREAK!
Refreshments in the Foyer.
® Questions and Troubleshooting

® 4:45 - 5:45 Active break to the
practice site!

® 5:50 - 5:55 Exporting Data
® 5:55-6:00 Wrap Up & Questions



® Basics of the iPad
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iSOPARC Menu Change to Load Mode

Home _ : ARK / LARGE AREA
Summarize data for submission

Project Unique Identifier (TEST) For practice use only
gy Scan Space & Photos N " Park ID#
Map the Target Area
* Description
) Counter 3
=¥ Scan tool * Address
* City
a SE;EJOd;z > Fixed fields on each observation.
& Project [ TARGET AREA >
E Edit and export project data > ( : ’ '

Area Information

L, General > | *Map NOT IMPORTED

Fixed fields on each observation.

Help
[a] A Q
0 Tutorial & Function Manual < Sebiils

About ISOPARC > Observation Information

* Counter Data NOT IMPORTED

Variable fields. Must be filled in on each observation.

Submit Observation I Save Park / Large Area

Home
Large Area, Target Area, and Scans



iSOPARC Menu

12:25 PM

Project Export

% Home >
S ize data for issi

1T Scan Space & Photos 3

Map the Target Area
) Counter 3
=% Scan tool
Explore >
Saved data

Project

Edit and export project data

ﬁ, General >
Hel

0 Tutorgl & Function Manual >

[ AboutiSOPARC >

Submit Observation

For practice use only

CMS

Community Transformation Grant
1

Parks:1

Parks:1

Create a PROJECT

- Small (+) in bottom right hand corner



Add Project

BASIC INFORMATION

Project ID#

Description

Add Project
Project ID# ALR
Description Just for fun




12:26 PM

Add Project

BASIC INFORMATION

Project ID# ALR

Description  Just for fun

2123 g 2123

Input Basic Information then click ‘Save’.
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iISOPARC Menu Project Export

Home .
% s ize data for submissi > For practice use only
CMs Parks:1

1T} Scan Space & Photos >

Map the Target Area Community Transformation Grant

1 Parks:1
D Counter >
== Scan tool
Just for fun
Parks:0
a Explore y
Saved data

Project

Edit and export project data

ﬁ, General >
Help

o Tutorial & Function Manual 4

(Il AvboutiSOPARC >

Submit Observation

Now you have a Project!
Next...........go back to your HOME screen.



iISOPARC Menu

Current Observation

Home

Summarize data for submission

can ce & Photos
pag Scan Spa

Map the Target Area

49 Counter

Scan tool

//':

Explore
Saved data

Project
Edit and export project data
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General

Help

Tutorial & Function Manual
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About iISOPARC
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PARK / LARGE AREA

Project Unique Identifier (ALR) Just for fun

* Park ID# . i .
Project Unique Identifier

* Description
P (ALR} Just for fun v

" Address
(TEST) For practice use only

* City

(CTG) Community Transformation Gr...

Fixed fields on each observal

TARGET AREA

Area Information

" Map NOT IMPORTED
Fixed fields on each observa!

SCANS

Observation Information

* Counter Data NOT IMPORTED

Variable fields. Must be filled in on each observation.

Select “(ALR) Just for fun’ as the Project Unique

Identifier.
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iSOPARC Menu

Home

Summarize data for submission

Scan Space & Photos
Map the Target Area.

Counter

Scan tool

Explore

Saved data

Project
Edit and export project data

General

Help

Tutorial & Function Manual

About iISOPARC

Submit Observation

Input

Variable fields

PARK / LARGE AREA

Project Unique Identifier
* Park ID#

* Description

* Address

* Gty

Fixed fields on each observation.

TARGET AREA

Avrea Information

Map

Fixed fields on each observation

SCANS
Observation Information

* Counter Data

Park ID#: 309

Description: Paradise Point Hotel

Must be filled in on each observation

(ALR) Just for fun

NOT IMPORTED

NOT IMPORTED

Save Park / Large Area

Address: 1404 Vacation Ave.

City: San Diego
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Home
Summarize data for subm

Scan Space & Photos

Map the Target Area

Counter

Sean tool

Explore

Saved data

Project
Edit and export project data

General

Help

Tutorial & Function Manual

About ISOPARC

iSOPARC Menu

Project Unique Identifier

Fixed fields on each observation

Observation Information

Must be filled in on each observation

(ALR) Just for fun

309

Paradise Point Hotel

1404 Vacation Ave

San Diegg

NOT IMPORTED

NOT IMPORTED
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iSOPARC Menu < Home Area Information

Summarize data for submission

— Home -

Import Scan Space
1T} Scan Space & Photos >
e D BT Total Area 0.00 sg.m.
. Counter Read-only data. Must be imported from the button above.
’ S »
L can tool
GENERAL INFO
Explore ) * Target Area ID#
Saved data
Description
&= Project > wt
E=N  Edit and export project data
* Surface NOT SELECTED
.n,‘ B > Area Type NOT SELECTED
Fixed fields on each observation.
o Help 3 | OPTIONAL DATA
Tutorial & Function Manual
Location NOT SELECTED
(] AboutiSOPARC >
Fixed Setting NOT SELECTED
Improvement Overlap

Submit Observation Save Target Area

Under Target Area click: Area Information



General Info 2
Target Area ID# 1

9% -

12:32 PM

-
iSOPARC Menu < Home Area Information
Import Scan Space

Home
Summarize data for submission

Total Area 0.00 sg.m.

Read-only data. Must be imperted from the button above.

(LT Scan Space & Photos >
Map the Target Area GENERAL INFO

Target Area ID#

,. Counter >
T Scan tool
Description Open Field
a Explore > Surface
Saved data
) * Area Type
= Project >
=8 Edit and export project data Fixed fields on each observation.

OPTIONAL DATA

-l:!-, General >
Location NOT SELECTED
0 Help N Fixed Setting NOT SELECTED
Tutorial & Function Manual
Improvement Overlap
(] ApoutiSOPARC >

Comments

These fields are optional.

Submit Observation Save Target Area

Description  Open Field




iSOPARC Menu
Current Observation

Home

can ce & Photos
pg Soan Sea

Map the Target Area

Counter
Scan tool

Explore

Saved data

Project
Edit and export project data

=
=

General

o)

Help

Tuterial & Function Manual

e O

About iSOPARC

12:32 PM

Total Area

Black top / asphalt

Read-only data. Must be imp

Cement
GENERAL INFO

Dirt
Target Area ID#

Gravel
Description

Sand
* Surface

Wood chips
* Area Type

Fixed fields on each observation.

OPTIONAL DATA

Location
Fixed Setting
Improvement Overlap

Comments

These fields are optional.

*Surface

Grass

*Area Type

Lawn

Area Information

NOT SELECTED
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North Carolina

NOT SELECTED

NOT SELECTED

NOT SELECTED

NOT SELECTED

iSOPARC Menu

Current Observation

Scan Space & Photos
Map the Target Area

Counter
Scan tool

Explore

Saved data

Project
Edit and export project data

General

Help

Tutorial & Function Manual

About iSOPARC

12:32 PM

Area Information

Import Scan Space

T2ial A\ren NOT SELECTED
Read-only data. Must be imp

Court
GENERAL INFO

Play space
Target Area ID#

Field
Description

Lawn
Surface

Picnic area
* Area Type

Pool

Fixed fields on each observal

OPTIONAL DATA

Location
Fixed Setting
Improvement Overlap

Comments

These fields are optional.

0.00 sq.m.

Open Field
Grass

NOT SELECTED

NOT SELECTED

NOT SELECTED




Park / Large Area saved.

OK

Unable to save Target Area.
Target Area with unsaved Park /
Large Area.

OK
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iSOPARC Menu <{ Home Area Information Change to Insert Mode

Home

Summarize data for submission

Import Scan Space
g Scan Space & Photos >
P SR T Total Area 0.00 sq.m.
o’ Counter > Read-only data. Must be imported from the button above.
- - Scan tool
GENERAL INFO
a Explore N Target Area ID# 1
Saved data
. Description Open Field
= Project > P P
ESE  Edit and export project data
Surface Grass
ﬂu . s Area Type Lawn
Fixed fields on each observation.
0 Help » | OPTIONAL DATA
Tutorial & Function Manual
Location NOT SELECTED
(] AboutiSOPARC >
Fixed Setting NOT SELECTED
Improvement Overlap

Submit Observation Save Target Area

Here is our Target Area Information
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iSOPARC Menu fe enL Scan Space & Photos

Home

S ize data for

Scan Space & Photos

Map the Target Area

Counter

Scan tool

Explore 3
Saved data

Project >

Edit and export project data

General >

Help >

Tutorial & Function Manual

About ISOPARC >

Submit Observation Navigate
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iISOPARC Menu Hide Menu Scan Space & Photos

% Home
5 ize data for submissi

LT Scan Space & Photos

Map the Target Area

Gounter
Scan tool

S

a Explore >
Saved data

= Project

B2 Fdit and export project data >

e

General > ;

Help

o Tutorial & Function Manual

About iISOPARC

Submit Observation Navigate

Click the writing tool at the bottom of your screen.

Begin plotting your area by placing your finger at
desired starting point.
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iSOPARC Menu Hide Menu Scan Space & Photos

¥

Home

Summarize data for submission

Scan Space & Photos
Map the Target Area

Counter

= Scan tool

a Explore >
Saved data

=n

=n

=2

Project >
Edit and export project data

ﬁ, General >

o Help 3
Tutorial & Function Manual

() AboutiSOPARC

Submit Observation Navigate

Complete your polygon
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iSOPARC Menu Scan Space & Photos

T

Current Observation

Home
S ize data for submissi

1T Scan Space & Photos

Map the Tarc a

Counter
Scan tool

Explore 3

Saved data

[l

Project 5

Edit and export project data

General >

&

Help 5

Tutorial & Function Manual

e 0

About iISOPARC >

Submit

Click “Register’ in the Upper right hand corner.

Select “‘Scan Space’.
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iSOPARC Menu ( Home Area Information Change to Insert Mode

Home
Summarize data for submission

Import Scan Space
“i Scan Space & Photos 3
bR Total Area 971.59 sq.m.
- Counter Read-only data. Must be imported from the button above.
_' Scan tool >
GENERAL INFO
a Explore 5 Target Area ID# 1
Saved data
. Description Open Field
& Project 5 P P
E=N  Edit and export project data
Surface Grass
,n,ﬂ General N Area Type Lawn
Fixed fields on each observation.
o Help 3 | OPTIONAL DATA
Tutorial & Function Manual
Location NOT SELECTED
(] AboutiSOPARC >
Fixed Setting NOT SELECTED
Improvement Overlap

Submit Observation Save Target Area

Screen Check



Target Area saved.

OK

Click “‘Save Target Area’ in bottom right hand corner.

A message will appear saying “Target Area saved.”



iISOPARC Menu Hide Menu Counter

Current Observation

- 1 s
Home ) : iy R et

Summarize data for submission

Scan Space & Photos
III Map the Ta?g?et Area ?

Explore
Saved data

m

Project
Edit and export project data

&

General

Help

Tutorial & Function Manual

About iISOPARC

e 0Q

Submit Observation

Next, select ‘Counter’ from the Menu bar.

Then, click ‘Hide Menu’ at the top of the screen (red circle).
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Menu Counter m
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After MALE counts....
Black boxes total the MALE counts.
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After FEMALE counts....
White boxes total the FEMALE counts.

12:50 PM

Counter
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Reset

Register Scans

w il v

11 7]

To register a scan...

Click the box In the upper right hand corner
(red circle), then select ‘Register Scans’.



Confirmation

Are you sure you want to REGISTER
your Scans?

Screen Check




Success message will appear.

Click OK.

Counter Data Import
All data has been imported.

Please fill the Main Activity for both

gender.

OK




iSOPARC Menu

Home

Summarize data for submission

LT Scan Space & Photos >
Map the Target Area

." Counter >

=% Scan tool

Explore >

Saved data

kD

Project >
Edit and export project data

ﬁ, General >
Hel

o TutorEI&Function Manual )

(] AboutiSOPARC >

Submit Observation

12:50 PM

< Home Observation Information

Male

Female

Read-only data. Must be imported from the button above.
OBSERVER

Observer ID#
Name

Reliability

LOCATION & TIME

Coding Station

Date
Start Time

End Time

Observer ID# Pick a 2-digit #

Name: Input your first name

T b 76% @)

Change to Insert Mode

33

27

Feb 24, 2014
12:49 PM

12:50 PM



Scroll down....

12:51 PM

¥ % 75% (mm )

iISOPARC Menu ( Home Observation Information Change to Insert Mode

Date

Feb 24, 2014
Home

Summarize data for submission

Start Time 12:49 PM
End Time 12:50 PM
LT Scan Space & Photos >
P e Observation Period Noon
) Counter » | Elapsed Time
- - Scan tool
AREA CONDITIONS
a Explore >
Saved data Accessible
i= Project
E Edit and export project data > Usable
Equipped
ﬁ, General >
Supervised
o Help . Organized
Tutorial & Function Manual
Check conditions to describe specific conditions for this scan area.
(] AboutiSOPARC >
MALE
Activity Type Primary Activity
Categories Sport
Submit Observation

Area Conditions: answer 5 Yes/No questions
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iSOPARC Menu m Observation Information

Check conditions to describe specific conditions for this scan area

MALE
Activity Type Primary Activity
Scan Space & Photos
L]} e the TE; e » | Categories
* Main Activity ) NOT SELECTED
#a Counter Categories
f. Scan tool ?
Fitness
Activity Level
Explore > Sport v
Saved data Sedentary . @
Project - Active Game
Edit and export project data Walking Sedent m
edentary
Vigorous
£ General > ¢ NO ACTIVITY |
Age Group 12:52 PM
O Help » | Child iISOPARC Menu e Observation Information
Tutorial & Function Manual
: Teen Current Observation " » " ;
@J About ISOPARC > Check conditions to describe specific conditions for this scan area
Adult Home
Summ a for su MALE
Sl Activity Type Primary Activity
LT Scan Space & Photos s | Categories Sport
Map the Target Area
* Main Activity
Scroll down iy Gounter >
LR ~¥  Scan tool
Main Activity
Activity Level
1) Choose from g oo ) ‘
Saved data Sedentafy m
‘Categories’ list for 8 [ ’
g B Edit and export project data Walking 10}
Basketball
Vigorous , (o]
MA L ES {1-‘ General > Cheer leading
Age Group
Dance
m c 1 Help Child
2) C h O O S e f r O M a I n Tutorial & Function Manual 4 Football

About iISOPARC y | Teen Handball o

ACthlty, |iSt fOF MALES Adult (8]

Senior [0]

e Q




12:52 PM

iSOPARC Menu Observation Information

FEMALE
LT Scan Space & Photos s | Activity Type
Map the Target Area
Categories
-,. Counter >
7 Scan tool * Main Activity ) NOT SELECTED
Categories
Fitness v
Explore
a SavEd data > Activity Level
) Sport
Project >
B2 Edit and export project data Sedentary
Active Game
Walking (5]
£ General > ST
% )
Vigorous
g NO ACTIVITY ©
O Help > Dl 12:52 PM
Tutorial & Function Manual
Child iISOPARC Menu - Observation Information
[l AboutisoPARC >
Teen Current Observation
Adult Home Senior
Summar f
Senior
FEMALE
1] Scan Space & Photos > Activity Type Primary Activity
Map the Target Area
R t for FEMALES e e
e p e a. O ‘ Counter >
~E7 Scan tool Main Activity
a Explore 5 ‘ Main Activity
Saved data Activity Level
_ . NOT SELECTED
= iject . > | Sed
ESR  Edit and export project data entary Artwork
worl
Walking (5]
ﬁ' Chess/checkers/cards
%, General > _
Vigorous [3]
Lying down
e Grou
O He‘P ) > o " Picnicking (food involved)
Tutorial & Function Manual
Child '
@J About iISOPARC > Reading
== Standing o
Adult

Senior [0]




12:54 PM
iSOPARC Menu e
Insert any specific comments here,
Current Observation

% Home
Summarize data for submission

Main Activity Sitting

Activity Level
g Scan Space & Photos > | sedentary
Counter > Walking ©
Sean toc! Vigorous (3]
Explore N Age Group
— o ohid
Q W E R T Y U O P <xJ
A S D F G H J K L return
B 2 Ex B c B viBsBENEM : ? 4
2123 g 2123

Scroll down....

Select ‘Comments’. You can add any comments
related to the observation if you wish.



Submit Observation!
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iSOPARC Menu

Home

Summarize data for submission

Scan Space & Photos
Map the Target Area

Counter

Scan tool

Explore
Saved data

Project
Edit and export project data

General

Help

Tutorial & Function Manual

About iISOPARC

Submit Observation

12:54 PM o« i 76% EE)

€ Home Observation Information Change to Insert Mode

Main Activity Sitting

Activity Level

Sedentary

Walking

o o B

Vigorous
Age Group
Child
Teen

Adult

e 0 o

Senior

Comments Insert any specific comments here.

Photos NOT LOADED

xase register photos on Scan Space & Photos.

Click the button in lower left corner (red

circle).



Observation saved.

OK

Success Message appears: “Observation
saved.”

Click OK.




iISOPARC Menu

Home 3

Summarize data for submission

LT Scan Space & Photos 5

Map the Target Area
» Counter
_‘ Scan tool >
a Explore 3
Saved data

Project

Edit and export project data

ﬁ, General >
Hel

o Tutorial & Function Manual >

(] AboutiSOPARGC >

Submit Observation

12:55 PM

Project Export

For practice use only

CcMms

Community Transformation Grant
1

Just for fun

309

1§ 74y -

Select Projects
Parks:1

Parks:1

Parks:1

Exporting Data

Project tab = click ‘Select Projects’ in
upper right hand corner (red circle).
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iISOPARC Menu Project Export Cancel

Home .
% A - > I':rm practice use only .
CMS arks:

1T} Scan Space & Photos >

Map the Target Area Community Transformation Grant

1 Parks:1

»a Counter
_‘ Scan tool >
Just for fun
309 Parks:1
Explore >

Saved data

&= Project

=N Edit and export project data

L, General >

o Help >
Tutorial & Function Manual

(] AboutiSOPARC >

Submit Observation Export (1)

N
Check the circle next to the project data that you

would like to Export.

Then click “Export (1)’ at the bottom of the screen.



Export Project(s)
How do you want to export?

Incremental

Cancel

Select either ‘Total’ or ‘Incremental’



Cancel iSOPARC: Exported Data on 2014/02/24 12:56

To: ctgdatacollection@gmail.com
Cc/Bee:
Subject: iISOPARC: Exported Data on 2014/02/24 12:56

Powered by CIAFEL.

3

HEADER_A...24_1256.csv

Troy

Export Project(s)

Project|s} exported with success!

Email will have attached
.CSV file with observations.

OK

Click Send!



Thank youl!
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